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Changing the View of a Design 

- if you don’t see a grid in the Fusion 360 window, as shown below, click on Grid and Snaps and check Layout Grid.  Displaying 

the Layout Grid is a matter of preference.  When designing for 3D printing, it can be used to represent the build plate. 

- click on the Orbit tool and click somewhere on the Grid to practice rotating and changing the angle of the view. 

- click on the Pan tool and then on the Grid to practice moving the view laterally. 

- after using the Orbit or Pan tool one must press the Esc key to exit that mode. 

- use the Mouse Wheel to practice Zooming in and out. 

 

 

Here is a close-up of the View Cube at the top right of the window. 

- click on the View Cube and move the cube while holding the mouse button down.  This is another way to rotate the view. 

- click on the Top of the View Cube and note how the view just jumped to a Top View. 

The View Cube now resembles that on the right. 

- click on the Curved Arrows at the upper right of the View Cube and practice Rotating the View. 

- click on the Arrows at the sides of the View Cube to practice jumping to various Views. 

- click on the Home icon to the upper left of the View Cube.  This can always be used to reset the view to the Home View 

 

 

 

 

 

 

If you don’t see the grid lines on the Plane use the 
Grid and Snaps menu and check Layout Grid.  It is 
personal preference to have the grid visible or not. 

Orbit tool 

Pan tool 



Starting a Design in Fusion (START HERE) 

- open Fusion.  If there is no icon on the Desktop, use the Windows search (magnifying glass icon) and type  fusion 

- from top File icon select Save and name the file. 

   Use your name followed by _Sign  e.g.  JoeBarbetta_Sign  (note the use of the underscore) 

 

Note that by default Fusion saves your project to “the cloud”, which are the servers managed by AutoDesk.  When you log into 

Fusion on a different computer, your projects will be available. 

As you work you may want to occasionally save your work in case Fusion crashes or we lose power. 

 

- in the left "BROWSER" click the arrow next to Document Settings 

- click on the edit icon that appears to the right when you hover over Units 

- ensure Active Units are set to Units: in, ouncemass and click OK.  You can also enable Set as Default if it is not grayed out. 

 

 

Note that the default units are in mm, which we just changed to inches. 

 

 

Did you know that the default units have changed over the 

years?  The earliest version used cubits as the default unit. 
 

 

 

 

 

 

 



Creating the Substrate Component 

To keep a project organized it is recommended to create a new Component for each part. 

 

- right-click on the Project Name at the top of the BROWSER and select New Component 

- set Name as  Your first name and last name initial followed by _Substrate    e.g. JoeB_ Substrate  and click OK 

   

 

 

The new Component should show in the Browser. 

Note that the area around the name is darkened and the circle with the dot.  This indicates that it is the Active Component. 

  

 

One reason to hate Fusion! 
When a project is saved and then reopened, the Component that was Active is no longer Active. 

If one wants to continue working on a Component, it must be reactivated by right-clicking on the Component Name and 

selecting Activate.  One can also click on the circle to the right of the Component name. 

 

 

 



Creating the First Sketch 

 

 

- select the top Create Sketch tool and click on the bottom rhombus to select the X-Y Plane. 

If a tool can’t be found, one can always look in the CREATE and MODIFY menus for it. 

 

 

- click on the arrows next to the Component and Sketches folder to open them 

- right click on the Sketch name, select Rename from the menu and rename the Sketch to Bottom 

 

 

 

 

 

 

 

 

 



- zoom in as shown below.  The scale labels can give an idea of how far one is zoomed in.  The View Cube should indicate you 

are sketching on the Top  X-Y Plane. 

- select the Rectangle tool.  If its icon is not visible, find it in the CREATE menu. 

- click on the Origin, and extend the other corner up and to the right 

- type 1.5, press the Tab key, type 2.0, and press the Enter key 

 

 

 

This should be the result.  The thin line extending away from the rectangle and that with the arrows and values are Dimension 

Lines.  It is OK if these lines have different positions. 

If one ever needs to change a dimension, one can double-click on a Dimension Value and change it. 

 

 

 

 

Origin 



- select the Fillet tool.  If its icon is not visible, find it in the MODIFY menu. 

- click on the corner at the Origin and then the other 3 corners 

 

 

- type 0.15 and press the Enter key.  Any warning message can be ignored. 

 

 

- click Finish Sketch at the bottom of the SKETCH PALETTE window 

 



- click on the Home icon at the View Cube 

- select the Extrude tool.  If its icon is not visible, find it in the CREATE menu. 

 

 

- for Distance enter 0.08 and click OK 

 

 

This should be the result. 

 



Creating the Component for Text 

 

- click on the circle for the Project Name.  Note that using this circle is an alternative to right-clicking and selecting Activate. 

- right-click on the Project Name at the top of the BROWSER and select New Component 

- set Name as  Your first name and last name initial followed by _Text    e.g. JoeB_Text  and click OK 

 

 

At this point the Substrate body may be dark, as shown below, or it may be “ghosted”.  This depends on settings in Fusion.  It 

doesn’t matter if it is ghosted or not.  Note that the new Component is automatically Activated when first created. 

 

 

- select Create Sketch and click on the top surface of the Substrate.  Rename the Sketch to Text. 

 



- from the CREATE menu, select Text 

- if a Parametric Text window appears, click its bottom right OK button 

 

 

- click on a point near the top left corner (the location is not critical) and extend the rectangle down and to the right 

 

 

- click on a point about 1/2 the way down and near the right edge. The location is not critical. 

 



- in the Text box enter your 3 initials preceded and followed by a single quote, e.g. ‘JPB’ 

- click on the Bold and Italic icons to highlight them blue 

- set the Height to 0.60 

- select the 2 center Alignment options and click OK 

 

 

- under your initials create a design using the Line, Circle, Spline tool, etc.  Here a simple rectangle was created to demonstrate 

later steps, but you can do much better.  Time to earn that art credit. 

- if desired, one can right-click on the text and select Edit Text and change the Height of the text or any other text parameters 

- when done, click Finish Sketch 

 

 

 



- hold down the Shift key and click on your initials (or other text) and then the bottom shape(s) to cause all of the to turn blue 

 

 

- select the Extrude tool 

- for Distance enter 0.02 and click OK 

 

 

The result should look like that below.  Of course with you customizations. 

 



- right-click on the Text Component and select Physical Material 

 

 

- scroll down to the Plastic folder and click on it 

- drag the ABS Plastic icon onto the Text Component 

As of this writing, PLA, which is a more common 3D printing material, does not appear in the list.  It actually doesn’t matter 

what material is selected in Fusion.  The filament loaded into the printer determines the material and color.  We are applying a 

plastic and then changing its color just for aesthetics in Fusion. 

 

 

- right-click on the ABS Plastic icon and select Edit 

 



- click on Advanced 

 

- select the Appearance tab and click on the drop-down menu button and select Edit Color… 

 

 

- select a color by either clicking on a Basic colors box or color spectrum box.  The brightness can be adjusted with the right-

side slider.  Click OK. 

 



- click OK at the bottom of the Physical Material window 

 

 

The Text and Art should change color. 

 

 

 

 

Exporting STL files 

 

- right-click on the Substrate Component and select Save As Mesh 

 



- set Format to STL (Binary) and Unit Type to Millimeter 

 

 

- ensure that Save to my computer is checked 

- note the save location.  By default it should be the computer’s Downloads folder.  If desired, one can click the button with 

the 3 dots to change the save location. 

 

 

 



- right-click on the Text Component and select Save As Mesh 

 

 

- change Structure to One File and click OK 

Note that the Structure option was not available when a STL was created for the Substrate Component.  It is now an option 

because there are multiple bodies in the Component for the different letters and art shape(s).  The alternate Structure option 

is One Body Per File, which would result in a STL file being created for each body.  In this case we only want a single STL file for 

the text and art shape(s). 

 

 

 



Using Cura – Dual Component 

 

Cura is a free Slicer program offered by Ultimaker, which can be used with many different 3D printers, including those from 

manufacturers other that Ultimaker.  The initial instructions apply to using a printer with a dual extruder.  Afterwards, 

instructions for using a less expensive printer with a single extruder will be offered. 

A printer with a dual extruder allows two different filament spools of different colors to be loaded at once and the printer will 

automatically switch between them. 

A printer with a single extruder, will require the printing to be paused after the substrate is printed.  The filament is then 

manually changed and primed and then printing is resumed.  Note that multiple dual color items can be printed with the need 

for a single filament change, if the substrates are all the same heights. 

This section is for a model that has been separated into 2 STL files.  One for each color.  If there is only 1 STL file, one can 

consult the Using Cura – Single Component section. 

 

- from the File menu, select Open File(s)… 

 

 

- navigate to the location of the files, which should be the Downloads folder and select both the Text and Substrate files 

- click Open 

 

 



- ensure that the PREPARE view is selected 

By default Cura should place the two components next to each other on the build plate. 

 

 

- click on the Text Component and then on the Extruder 2 icon at the bottom left 

 



- hold the Shift key and click on the both the Substrate and Text components 

- from the Edit menu, select Merge Models 

 

 

This should be the result of the Merge. 

 

 

 



- click the bottom right Slice button 

 

 

- click on the top center PREVIEW selection and then on the Color scheme options arrow 

By default, Cura assigns colors to match Line Types. 

 

 

- change the Color scheme to Material Color 

Note that the color is assigned according to Extruder number. 

 

Note the Brim color.  The Brim 

is a single layer printed around 

the part to help ensure 

adhesion to the print bed.  The 

Brim is then peeled away when 

the print is done. 

From experimentation with a 

specific printer, one can 

determine if a Brim is 

necessary. 

This result shows that most of 

the Brim is printed using 

Extruder 1.  The following page 

will show settings to change the 

Extruder that prints the Brim. 



- at the top right of the Cura window, click on the Settings arrow  

- select the Extruder 1 tab 

- click on the Settings Options icon and select All in the menu that appears 

 

 

- in the Search box enter brim and scroll to the Build Plate Adhesion section 

- change the Build Plate Adhesion Extruder to Extruder 1 

- change Brim Distance to 0.24 

 

 

Changing the Brim Distance will allow the 

Brim to be more easily removed from the 

print, however, a value that is too large 

can make the Brim less effective. 

The Brim Width and Brim Line Count can 

be different.  These values may be 

reduced to reduce the Brim material. 



Using Cura – Single Component 

 

The previous section was for a model that was separated into 2 Components and thus 2 STL files.  This section presents 

instructions for a single Component model and thus 1 STL file. 

Because only a single STL file is imported, one cannot easily assign an extruder to different components.  However, Cura does 

allow one to define regions of a model, that can be assigned different extruders.  This method will use the Support Blocker 

tool.  This tool is meant to define areas of a model where supports will not be added.  We will not being using supports, but 

will use this tool to define regions to specify the Extruder to use for each region. 

This method can be made easier by installing the Measure tool plug-in.  One would think that Cura would have this built-in by 

default, but the feature has to be downloaded. 

One should be able to download this tool without having to sign in or creating a Ultimaker account.  If there are any issues with 

the download, the download of the measuring tool can be skipped. 

 

- at the top right of Cura, click on the Marketplace button 

 

 

- type measure in the Search box 

- click Install for the Measure Tool and then Accept for the License Agreement 

- Close and Reopen Cura 

 

 

 

 

 



- from the File menu, select Open File(s)… 

 

- navigate to the location of the files, which should be the Downloads folder, select the file, and click Open 

 

- use the mouse wheel to zoom into the model.  Moving the mouse while holding the mouse wheel down allows panning the 

view.  Right-clicking on the model or build plate allows changing the angle. 

 



- if the Measure tool was installed, click on it an then click on the top surface where there is no text or shapes and make note 

of the Z value.  Here it is 2.032 mm, which matches the 0.08 in that was used in Fusion. 

 

 

- click on the top surface of a letter or shape to add a 2nd point.  Here we can see that that Z value is 2.54 mm (0.100 in), 

which is the result of extruding the text and shapes 0.02 in above the 0.08 in substrate.  The Z Distance value of 0.508 mm 

matches the 0.02 in. 

 

 

 

 



- note the Dimensions at the bottom left of the Cura screen.  Here the Dimensions shows as 50.8 mm x 38.1 mm x 2.5 mm, 

which corresponds to 2 in x 1.5 in x 0.1 in 

- add 4 mm to the Length and Width values, which results in 54.8 mm and 42.1 mm.  These 2 values will be used to define the 

Length and Width of the Support Blocker that will be used for the substrate.  The Height of the substrate, 2.032 mm, which 

was determined by the Measure tool, will be used for the Height of the Support Blocker.  If the Measure tool was not 

available, we would know this value from that used in Fusion. 0.08 in = 2.032 mm 

 

 

- click on the Support Blocker tool and then on the center of the model 

 

 

- select the Scale tool, which should show the initial dimensions 

 



- uncheck Uniform Scaling 

- set X, Y, Z to the Length, Width, and Height values, specified on the previous page 

 

 

- select the Move tool use the red and green arrows to position the Support Blocker so that it surrounds the model.  The 

centering is not critical.  There just needs to be some Support Blocker material around each edge of the model. 

- set Z to 0 

 

 

 

 

 

 



- select the Per Model Settings tool and the Overlaps icon 

 

 

- change the setting to Cutting mesh 

 

 

- click on the Extruder 1 icon 

 



The following steps will create a 2nd Support Blocker that will be placed above the Support Blocker for the substrate and will 

thus contain the text and shape(s). 

 

- right-click on the Support Blocker and select Multiply Selected 

 

 

- click OK 

 

 

 

 



- select the Top View at the bottom left of the Cura screen 

 

 

- select the Move tool and use the arrows to position the Support Blocker over the bottom one 

 

 

- set the Z value to 2.032, which is the Height of the Support Blocker for the substrate 

 

 



- click the bottom right Slice button 

 

- click on the top center PREVIEW selection and then on the Color scheme options arrow 

- change the Color scheme to Material Color 

 

 

Note that the color is assigned according to Extruder number.  If needed an Eraser can be selected and then an Extruder icon 

can be selected to reassign a Extruder and thus change the color.  The top Eraser is for the Substrate and the bottom Eraser is 

for the Text and Shape(s).  The Slice button must be clicked again. 

 



Using a Single Extruder Printer 

 

This method will actually be the easiest to setup in Cura. 

 

If the model is comprised of 2 Components, follow the Using Cura – Dual Component section up to and including the point 

where Merge Models is used. 

If the model is comprised of 1 Component, follow the Using Cura – Single Component section for opening the file.  The 

Measure tool is not needed. 

 

Once the model is open, one wants to create a pause after the layers for the Substrate are complete to allow one to manually 

change the filament.  This can be straight forward in some slicer programs, but in Cura, at the time of writing, the G-Code must 

be modified. 

 

- perform the Slice operation and then select Preview 

- move the right side slider to its bottom position and then move the slider up until the Text and Shape(s) become visible.  Here 

that happened at layer 13.  This determines that the last layer of the Substrate is 12. 

 

 

 

 

 

 

 



- from the Extensions menu, select Post Processing and Modify G-Code 

 

- click Add a script 

 

- select Filament Change 

 

- set the Layer value to the 1st layer of Text and Shape(s) and click Close 

 

Research and experimentation 

should be done for the 

particular printer used. 


